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Preface

This Users’ Guide supports the use of the RICELEAS  Lotus 1-2-3 release 5.0 template on either
conventional Windows 3.1 or Windows 95 microcomputer operating systems.  Users of this
program are advised to obtain a complementary copy of “Landowner/Tenant Issues in the Texas
Rice Industry,” Agricultural and Food Policy Center Policy Issues Paper 96-3, which discusses in
some detail the FAIR Act of 1996 and its implications for a rice farm operator and landowners. 
Even though cotton- and grain-related transition payments are of much lower magnitude ($/ac)
than for rice, similar sets of software were prepared for use by operators and landowners.  Copies
of the software, Users’ Guide, and the noted paper may be obtained either through your local
county agent, or Larry Falconer in Corpus Christi (512/265-9203), or Joe Outlaw in College
Station (409/845-3062).

The development of this software was funded by the Texas Agricultural Experiment Station
(project H-3914), Texas Agricultural Extension Service, Texas Rice Research Foundation, and
Rice Belt Warehouse, Inc.

Installation Instructions

The Rice Land Tenure Evaluation software is a Lotus template.  This means that the program
must be run using Lotus 1-2-3.  This program is designed to run with either Windows 95 or
Windows 3.1 or higher operating systems, and Lotus 1-2-3 release 5.  A computer with 8mb of
RAM and a 486 processor is also recommended, but not required.  Since the program is a Lotus
template, Lotus 1-2-3 must be running before you can load the program.  Once inside Lotus, you
must open a file.  At the top of the Lotus program you will notice a menu bar with several menu
options on it.  In the top left corner is the “File” menu item.  To open a file, pull down the “File”
menu and click the “Open” option.  Upon selecting the Open option, the Open File dialog box
will appear, as shown below.
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Under the “Drives” section, select the letter of the 3.5 inch drive on your computer.  Then select
the file entitled RICELEAS.WK4 from the list of files appearing along the left side.  Click the
OK button, and Lotus 1-2-3 r 5 will bring up the Rice Land Tenure Evaluation program.  You
will note there are several sheets comprising this spreadsheet file; the customized menu features
incorporated into the RICELEAS.WK4 file facilitate moving from one area of the spreadsheet to
another as necessary.  

After the program has loaded up, the first screen you should see is the opening screen
below:

If you do not see the opening screen above, something is not working properly.  Try and reload
the file, going back through the steps outlined above.  If problems persist, call Joe Outlaw in
College Station (409/845-3062).

Overview

What the Rice Land Tenure Evaluation Program is designed to do:  This Lotus template
takes enterprise budget information for rice farm operations and evaluates the expected returns to
producers and landowners under various lease scenarios.  The landowners’ results from renting
the land for rice farming are compared with their receiving 100% of the market transition
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payments plus the user-specified net returns from an alternative enterprise, thus calculating the
net advantage to landowners for renting their land for rice production under the budgeted
scenario over the life of the FAIR Act.

The Rice Land Tenure Evaluation Program allows the user to evaluate any desired share
arrangement, but for ease of use it contains fourteen default lease share options that the user may
select from, and then modify if desired.    

The user can print any one of six programmed reports by using the Print option on the menu. 
These reports include: 1) the base data on program yields, expected prices, and market transition
payments; 2) land tenure arrangements (landowners’ percentage of different cost items being
shared); 3) enterprise budget information; 4) sensitivity table analyses for both the tenant and
landowner for the current operating period; 5) sensitivity table analyses for the tenant over the
life of the FAIR Act; and 6) sensitivity table analyses for the landowner over the life of the FAIR
Act.  The user may also print all six reports at once.  An example of each of these reports appears
toward the end of this Users’ Guide.

Limitations:  This program was designed with a very specific purpose in mind, that being to
identify expected returns to landowners for two basic alternatives: (a) continuing to engage their
land in rice production, considering alternative tenure arrangements, expected production costs,
and ranges of expected yields, and prices; and (b) ceasing use of their land in rice production, and
engaging it instead in an alternative use, whereby they realize 100% of the market transition
payments and the user-specified net returns for the alternative enterprise.  Therefore, it is limited
in its analytical capabilities.  The Rice Land Tenure Evaluation is not designed to:

� Be prescriptive, i.e, indicate what one should do -- it simply evaluates alternatives based
on user-supplied data.

� Evaluate leasing options for alternative enterprises -- this program only evaluates rice
leases.

� Account fully for risk management -- it does not incorporate users’ subjective
probabilities for expected yields and prices, the option of crop insurance, or the effects of
marketing contracts, among other possible considerations.

� Allow for direct, side-by-side comparisons of tenure arrangements for the rice enterprise
as well as for other cropping alternatives.

A more comprehensive software program designed to address these issues will be available
during the Summer of 1997.
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Please Note:

The user may enter data in the cells that appear in blue text; blue text is “unprotected,” allowing 
users to change it, replacing it with their own values.  All other cells are programmed as
formulas, and should not be changed by the user.  Doing so will corrupt the integrity of the
program and result in the output being inaccurate.  To protect against such accidental changes of
formula cells, users are encouraged to maintain one or more original versions of the program in a
secure location.  Note: in this Users’ Guide, the unprotected cells appear in a light shade of
grey.    

Moving around the program: To move from one section to the next, simply access the pull-
down menus located at the top of the screen.  Inside this pull-down menu is a list of all the places
that you can go to inside the program.  To move around within any of the data entry or analysis
sections, use the mouse in conjunction with the horizontal and vertical scroll bars at the right
hand side and bottom of the display.  The arrow keys may also be used to move within a page.
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Required Data 

The data required to generate results are entered into the (a) Base Data, (b) Land Tenure,  and (c)
Budget sections.  These data include:

Base Data Section:

Analysis Description: This label is the information that will be printed in the heading of all the
pre-programmed reports.  It provides the user with the capability of labeling different analyses.

Farm Payment Yield: The established yield for a particular Farm Service Agency (FSA) farm
unit; this yield is used by the FSA for determination of market transition payments.  Be sure to
adjust this figure to the appropriate level for the farm unit being analyzed.

Main Crop Yield : Expected rice yield (dry weight) for the main crop in cwt/ac, for the farm unit
being evaluated.

Ratoon Crop Yield: Expected rice yield (dry weight) for the ratoon crop in cwt/ac, for the farm
unit being evaluated.  

Main Crop Rice Price: Expected harvest time price ($/cwt) for main crop rice for the budgeted
period.

+/- Increments for What If : The price and yield increments in $/cwt and cwt/ac that are used to
define alternative price and yield levels for the tenant and landowner sensitivity analysis tables. 
This program calculates returns under various yield and price scenarios.  The main crop yield and
price specified, along with the +/- increments, define the different yield and price levels used to
calculate the returns.  The sensitivity calculations are presented both for +/- one and +/- two
increments about the specified yield and price levels, i.e., a total of twenty five different yield and
price combinations are evaluated.

Ratoon Price as % of Main Crop: The percentage differential for the ratoon crop price as a
total percentage of main crop price (e.g., a 10% discount would be represented as 90%).

Alternative Return : These values represent net cash flows from the next best alternative
enterprise that will accrue to the landowner if the land is not rented to a tenant for rice
production.  These values are used to calculate the net advantage to the landowner for allowing
the land to remain in rice production and be farmed by a tenant producer.

Annual discount rate: This value is used in net present value calculations to adjust the tenant’s
and landowners’ cash flows to evaluate the net returns per acre over the 1996-2002 period.  A
desired rate of return for the land in the analysis could be used (e.g., 5-7%) or, alternatively, users
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may choose to use their opportunity cost of capital for borrowed funds (e.g., 7-12%).  Returns for
the 1996 crop year are not included in the net present value calculations since this crop year is in
the past, and as such, does not affect future decisions.  Note: once the 1997 crop year has
occurred, 1997 consequences should be excluded from the NPV calculations.  Call Joe Outlaw
(409/ 845-3062) or Ed Rister (409/845-3801) for information on how to make these revisions.

Land Tenure Section:

Analyze : This column of values is the current tenure arrangement being evaluated.  These data
may be selected from a set of default options from the menu bar using the Analyze menu.  The
user also has the option of customizing these scenarios by entering alternative values, or he/she
may enter an entirely new alternative directly into the worksheet.  The user may also alter the
percentages that are shown in the fourteen customized tenure arrangements, even though the text
is black.  These cells are not formulas and changing them will not affect the operation of the
program.  Any tenure specific allocation changes that the user wishes to keep for subsequent
analytical sessions need to be saved prior to exiting the program.  Then, the next time the
program is opened the customized tenure arrangements will be available, including any saved
changes; be advised, however, that the original tenure arrangements that were altered will no
longer be available -- for that reason, users are advised to keep an original version of this
template stored in a secure location.

Enterprise Budget Section:

The following four data items are required to determine the wet weight of rice being handled and
dried so that accurate harvest and post-harvest handling costs can be calculated.  Both main and
ratoon crop yield data are to be entered in dry weight terms.

Main Crop Harvest Moisture Percentage: The amount of main crop grain moisture when
harvested, e.g., 18-22%.

Ratoon Crop Harvest Moisture Percentage: The amount of ratoon crop moisture when
harvested, e.g., 18-22%.

Dry Moisture Percentage: The base moisture percentage for the rice to be marketed, or a target
moisture level for dry rice, e.g., 12-13%.

Handling Shrink : Percentage reduction occurring as yields are transformed to dry yields, due
primarily to handling losses, e.g., 0-1%.

Variable Production Input Levels and Costs:  All of the data entry regarding costs and inputs
is done in the Enterprise Budget Section. These data are mainly usage rates of variable inputs
with corresponding costs.  Fixed costs may be entered on a per acre basis near the bottom of the
enterprise budget (while these fixed costs will appear in the printed enterprise budget report, they
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are not considered in other aspects of the analysis (e.g., the sensitivity tables) as the fixed costs
are considered irrelevant to the “grow rice” vs “pursue an alternative enterprise decision” -- that
is, the fixed costs will occur regardless of the enterprises grown on the land; if additional future
capital expenditures are intended for land leveling, water well replacement, etc. to support the
rice enterprise, an amortized cost should be included in the variable cost section of the budget
under “miscellaneous”).  The areas that require data entry are colored with blue text, to
symbolize a data entry cell.  Do not enter data in cells that do not have blue text -- this will
cause a formula to be erased, and the program to function improperly (refer to the Please Note
item at the top of p. 4).  

Menu Options

File Menu:

The File Menu can be accessed by clicking on the File section of the menu.  The File
Menu contains options for opening, closing, and saving files.  

Open : the Open command allows the user to open a new file inside the Lotus program.    If you
open a new file, you will be leaving the Rice Land Tenure Evaluation program and opening
another Lotus spreadsheet file. 

Close : the Close command allows the user to close a file inside the Lotus program.  If you
choose the Close option, then you will be closing the Rice Land Tenure Evaluation program.  It
is recommended that the user save the current file by using the Save As option and entering an
analysis-specific file name before closing.

Save As? : the Save As?  command allows the user to save the current file.  You may save the
file under the current name, or change the name of the file and preserve the data under a analysis-
specific file name.  It is recommended to periodically save the file as you progress through the
worksheet.  This helps to prevent data loss due to an accidental data entry, or unforeseen program
shutdown by the computer system. 

Exit : the Exit  command allows the user to exit the Rice Land Tenure Evaluation program and
the Lotus 1-2-3 program.  It is recommended that the user save the data as discussed above
before exiting.  

Print Menu:

The Print Menu is a customized menu that allows the user to print a variety of reports. 
The option exists to print either one report at a time, all reports at once, or a user-specified
combination of the six reports.  The user can access the print menu by clicking the Print option
on the customized main menu bar.  After clicking on the Print menu, the user is presented with



8

the Print dialog box
shown at the top of the next
page.

Inside the dialog box, the user can select any combination of six pre-defined reports, and a cover
page.  To select the items to be printed, click on the box next to the title of the report(s) to be
printed and click OK.  Be sure your printer is on and loaded with paper before executing this
print command.

The available reports include: 

Base Data on Yields, Prices, and Transition Payments: this report contains the base data on
FSA program yield, expected yields, expected prices, annual $/ac cash flows for an alternative
enterprise over the remaining life of the FAIR Act, and the discount rate used in the analysis for
net present value calculations.

Land Tenure Arrangements: the specific land tenure arrangement (percentage of crop returns
and different cost items being shared) that is being analyzed for the particular scenario, along
with the rest of the available alternatives.

Enterprise Budget Information: the enterprise budget information that represents the cost
structure for the specific rice production scenario that is being analyzed.

Sensitivity table for landowner and tenant, net of payments: the sensitivity table analyses for
both the tenant and landowner for only the current operating period, net of (ignoring) any
transition payments.  
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Sensitivity table for tenant over the life of the FAIR Act: the sensitivity table analyses for the
tenant over the remaining life of the FAIR Act (1996-2002), including tenant’s designated share
of transition payments.  Positive values indicate returns exceed the tenant’s share of variable
costs while negative values indicate the opposite.

Sensitivity table for the landowner over the life of the FAIR Act: the left side represents the
sensitivity table analyses for the landowner continuing to rent his/her land to a tenant producer
for rice farming over the remaining life of the FAIR Act (1996-2002), including landowners’
designated share of transition payments.  Positive values indicate landowners’ share of returns
exceed the landowners’ share of variable costs while negative values indicate the opposite.  The
middle column of values represents the respective annual net returns realized by landowners who
discontinue their rice lease and engage their land in its next best use, while also receiving 100%
of the market transition payments.  The right side of this output represents the net advantage to
the landowner for continuing use of his/her land in rice production compared to using it in the
specified next best use and receiving 100% of the market transition payments.  A positive value
indicates returns are highest if rice production is continued with a tenant while a negative value
signals the landowners’ pursuit of the next best alternative accompanied by their  receipt of 100%
of the market transition payments are more profitable.   

The user may also print all six reports at once by selecting the All Information  option from the
dialog box.

Analyze Menu:

The Analyze Menu allows the user to select any of fourteen pre-defined land tenure
arrangements.  A user can select the option they would like to analyze by clicking on the desired
selection with the mouse, or by using the arrow and enter keys.  The program then over-writes
the contents of the Analyze column in the Budget page, and immediately updates all calculations
to reflect the desired tenure arrangement.  If the user changes any component of the tenure or
budget data, the REFRESH menu item needs to be executed as described on the next page. 
 
Move To Menu:

The Move To menu allows the user to move around throughout the worksheet.  By
selecting one of the seven options the user can move to the sections specified by that option.

Misc Menu:

The Miscellaneous Menu allows you to either (a) switch to the Lotus 1-2-3 menu or (b)
refresh the data and calculations inside the worksheet.
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Reset to 1-2-3 Menu:

  The Reset Menu allows the user to toggle to the standard Lotus 1-2-3 menu system.  If
you do toggle to the standard menu, after completing the intended Lotus tasks, you may then
return to the Rice Land Tenure Evaluation program’s customized menus by selecting the Menu
option that has been added on the far right side of the standard Lotus 1-2-3 menu bar.  

*IMPORTANT*

Refresh: allows a user who has changed data within the land tenure section or the
enterprise budget section to recalculate the sensitivity tables using the new data values.  For
example, if you select the 1/4a share arrangement from the Analyze menu, then the
program automatically computes the sensitivity tables using that data.  However, if you go
to the land tenure section and adjust the percentages after having selected a tenure
alternative, the program will not automatically update the tables.  Similarly, if you make an
adjustment on the Enterprise Budget section or elsewhere, such changes are not
automatically reflected on the results sections.  The user must move to the Misc menu and
choose the Refresh option.  The program then takes the data that has just been changed
and re-calculates the sensitivity tables.

Help Menu:

The Help Menu allows you to access the Lotus 1-2-3 help screens.

Reports

Each of the following six pages is an example presentation of the six respective reports
that may be generated using this program.  The values used in this example are for a case farm
situation in Wharton County (Wharton-El Campo, TX area) identified in December 1996.  
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 West Side of Texas Upper Coast (District 11)
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 !!" $/cwt $2.78 $/ac ($12.00)

 !!# $/cwt $2.74 $/ac ($12.00)

 !!$ $/cwt $2.94 $/ac ($12.00)

 !!! $/cwt $2.85 $/ac ($12.00)

%&&& $/cwt $2.61 $/ac ($12.00)

%&& $/cwt $2.11 $/ac ($12.00)

%&&% $/cwt $2.04 $/ac ($12.00)

�

����������

���
� % 10.00%
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West Side of Texas Upper Coast (District 11)

Net of Transition Payments
'(�
�)��*�+�������*�
�

��,��
��
���+����-����+���.��
�/

�.���������,0��1
/ 1/7
�������� $8.50 $9.00 $9.50 $10.00 $10.50

�.������ 51.90 (130.45) (106.29) (82.12) (57.96) (33.79)

,�1
���/ 54.40 (115.55) (90.32) (65.08) (39.84) (14.61)
56.90 (100.66) (74.35) (48.04) (21.73) 4.58
59.40 (85.76) (58.38) (31.00) (3.62) 23.76
61.90 (70.86) (42.40) (13.95) 14.50 42.95

'(�
�)��*�+�������2�
��1
����,��
��
���+����-����+���.��
�/

�.���������,0��1
/ 1/7
�	��
���� $8.50 $9.00 $9.50 $10.00 $10.50

�.������ 51.90 59.71 63.74 67.77 71.80 75.82

,�1
���/ 54.40 62.36 66.57 70.77 74.98 79.19
56.90 65.01 69.39 73.78 78.16 82.55
59.40 67.66 72.22 76.78 81.35 85.91
61.90 70.30 75.05 79.79 84.53 89.27
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�4�������*�5���6		���.���
�,���
���
�  /

Base w/o transition payments
MC Yield 1/7
(cwt/ac) �.���������,0��1
/
�������� $8.50 $9.00 $9.50 $10.00 $10.50

51.90 (130.45) (106.29) (82.12) (57.96) (33.79)
54.40 (115.55) (90.32) (65.08) (39.84) (14.61)
56.90 (100.66) (74.35) (48.04) (21.73) 4.58
59.40 (85.76) (58.38) (31.00) (3.62) 23.76
61.90 (70.86) (42.40) (13.95) 14.50 42.95

Annual, considering transition payments

1996 $8.50 $9.00 $9.50 $10.00 $10.50
51.90 (22) 2 26 50 75
54.40 (7) 18 43 68 94
56.90 8 34 60 87 113
59.40 23 50 77 105 132
61.90 37 66 94 123 151
1997 $8.50 $9.00 $9.50 $10.00 $10.50
51.90 (24) 0 25 49 73
54.40 (9) 16 42 67 92
56.90 6 32 59 85 111
59.40 21 48 76 103 131
61.90 36 64 93 121 150
1998 $8.50 $9.00 $9.50 $10.00 $10.50
51.90 (16) 8 32 57 81
54.40 (1) 24 49 75 100
56.90 14 40 67 93 119
59.40 29 56 84 111 138
61.90 44 72 101 129 158
1999 $8.50 $9.00 $9.50 $10.00 $10.50
51.90 (19) 5 29 53 77
54.40 (5) 21 46 71 96
56.90 10 37 63 89 116
59.40 25 53 80 107 135
61.90 40 69 97 126 154
2000 $8.50 $9.00 $9.50 $10.00 $10.50
51.90 (29) (5) 20 44 68
54.40 (14) 11 37 62 87
56.90 1 27 54 80 106
59.40 16 43 71 98 125
61.90 31 59 88 116 145
2001 $8.50 $9.00 $9.50 $10.00 $10.50
51.90 (48) (24) 0 24 48
54.40 (33) (8) 17 42 68
56.90 (18) 8 34 60 87
59.40 (4) 24 51 79 106
61.90 11 40 68 97 125
2002 $8.50 $9.00 $9.50 $10.00 $10.50
51.90 (51) (27) (3) 22 46
54.40 (36) (11) 14 40 65
56.90 (21) 5 31 58 84
59.40 (6) 21 48 76 103
61.90 9 37 66 94 122

NPV* $8.50 $9.00 $9.50 $10.00 $10.50
51.90 (128) (22) 83 188 293
54.40 (63) 47 157 267 377
56.90 2 117 231 346 460
59.40 67 186 306 425 544
61.90 132 256 380 504 628

*NPV is  for 1997-2002, discounted into 1997 $s .
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Rice is grown No Rice Advantage to growing rice
Base w/o transition payments Base w/o transition payments

MC Yield 1/7 MC Yield 1/7
(cwt/ac) �.���������,0��1
/ (cwt/a c�.���������,0��1
/
�	��
���� $8.50 $9.00 $9.50 $10.00 $10.50 ���
�� $8.50 $9.00 $9.50 $10.00 $10.50

51.90 59.71 63.74 67.77 71.80 75.82 51.90 71.71 75.74 79.77 83.80 87.82
54.40 62.36 66.57 70.77 74.98 79.19 ($12.00) 54.40 74.36 78.57 82.77 86.98 91.19
56.90 65.01 69.39 73.78 78.16 82.55 56.90 77.01 81.39 85.78 90.16 94.55
59.40 67.66 72.22 76.78 81.35 85.91 59.40 79.66 84.22 88.78 93.35 97.91
61.90 70.30 75.05 79.79 84.53 89.27 61.90 82.30 87.05 91.79 96.53 101.27

Annual, considering transition payments Annual, considering transition payments

1996 $8.50 $9.00 $9.50 $10.00 $10.50 1996 $8.50 $9.00 $9.50 $10.00 $10.50
51.90 78 82 86 90 94 51.90 (37) (33) (29) (25) (20)
54.40 80 85 89 93 97 54.40 (34) (30) (26) (21) (17)
56.90 83 87 92 96 101 $114.37 56.90 (31) (27) (23) (18) (14)
59.40 86 90 95 99 104 59.40 (29) (24) (20) (15) (10)
61.90 88 93 98 103 107 61.90 (26) (21) (17) (12) (7)
1997 $8.50 $9.00 $9.50 $10.00 $10.50 1997 $8.50 $9.00 $9.50 $10.00 $10.50
51.90 78 82 86 90 94 51.90 (35) (31) (27) (23) (19)
54.40 80 84 89 93 97 54.40 (32) (28) (24) (20) (16)
56.90 83 87 92 96 100 $112.55 56.90 (30) (25) (21) (17) (12)
59.40 85 90 95 99 104 59.40 (27) (23) (18) (13) (9)
61.90 88 93 98 102 107 61.90 (24) (20) (15) (10) (5)
1998 $8.50 $9.00 $9.50 $10.00 $10.50 1998 $8.50 $9.00 $9.50 $10.00 $10.50
51.90 79 83 87 91 95 51.90 (43) (39) (35) (31) (27)
54.40 81 86 90 94 98 54.40 (40) (36) (32) (28) (23)
56.90 84 88 93 97 102 $121.65 56.90 (38) (33) (29) (24) (20)
59.40 87 91 96 100 105 59.40 (35) (30) (26) (21) (17)
61.90 89 94 99 104 108 61.90 (32) (28) (23) (18) (13)
1999 $8.50 $9.00 $9.50 $10.00 $10.50 1999 $8.50 $9.00 $9.50 $10.00 $10.50
51.90 78 82 86 90 94 51.90 (39) (35) (31) (27) (23)
54.40 81 85 89 93 98 54.40 (37) (32) (28) (24) (20)
56.90 84 88 92 97 101 $117.56 56.90 (34) (30) (25) (21) (16)
59.40 86 91 95 100 104 59.40 (31) (27) (22) (18) (13)
61.90 89 94 98 103 108 61.90 (29) (24) (19) (15) (10)
2000 $8.50 $9.00 $9.50 $10.00 $10.50 2000 $8.50 $9.00 $9.50 $10.00 $10.50
51.90 77 81 85 89 93 51.90 (30) (26) (22) (18) (14)
54.40 79 84 88 92 96 54.40 (27) (23) (19) (15) (11)
56.90 82 86 91 95 99 $106.65 56.90 (25) (20) (16) (12) (7)
59.40 85 89 94 98 103 59.40 (22) (17) (13) (8) (4)
61.90 87 92 97 101 106 61.90 (19) (15) (10) (5) (0)
2001 $8.50 $9.00 $9.50 $10.00 $10.50 2001 $8.50 $9.00 $9.50 $10.00 $10.50
51.90 73 77 81 85 90 51.90 (11) (6) (2) 2 6
54.40 76 80 84 89 93 54.40 (8) (4) 1 5 9
56.90 79 83 87 92 96 $83.92 56.90 (5) (1) 4 8 12
59.40 81 86 90 95 100 59.40 (3) 2 7 11 16
61.90 84 89 93 98 103 61.90 0 5 10 14 19
2002 $8.50 $9.00 $9.50 $10.00 $10.50 2002 $8.50 $9.00 $9.50 $10.00 $10.50
51.90 73 77 81 85 89 51.90 (8) (4) 0 4 8
54.40 76 80 84 88 92 54.40 (5) (1) 3 7 12
56.90 78 83 87 91 96 $80.73 56.90 (2) 2 6 11 15
59.40 81 85 90 95 99 59.40 0 5 9 14 18
61.90 84 88 93 98 103 61.90 3 8 12 17 22

NPV* $8.50 $9.00 $9.50 $10.00 $10.50 NPV* $8.50 $9.00 $9.50 $10.00 $10.50
51.90 333 351 369 386 404 51.90 (128) (111) (93) (76) (58)
54.40 345 363 382 400 418 54.40 (117) (98) (80) (62) (43)
56.90 357 376 395 414 433 $461.70 56.90 (105) (86) (67) (48) (29)
59.40 368 388 408 428 448 59.40 (94) (74) (54) (34) (14)
61.90 380 400 421 442 462 61.90 (82) (61) (41) (20) 1

*NPV is  for 1997-2002, discounted into 1997 $s. *NPV is  for 1997-2002, discounted into 1997 $

Landowner takes all payment and alternative returns for 1997-2002.
Payment Altern Total

1996 126.37 -12.00 114.37
1997 124.55 -12.00 112.55
1998 133.65 -12.00 121.65
1999 129.56 -12.00 117.56
2000 118.65 -12.00 106.65
2001 95.92 -12.00 83.92
2002 92.73 -12.00 80.73

NPV97-02513.96 -52.26 461.70

16


